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ABSTRACT 
 
 

This manual documents the Strategic Mobility 211  Multi-Modal Terminal Model capabilities 
and functions.  The Model was created using Arena Basic version 10.00 from Rockwell 
Software, Inc. and extended using Visual Basic for Applications (VBA). Strategic Mobility 21 
(SM21) is an operational level concept that merges planning and execution of both commercial 
freight operations and the deployment and sustainment of joint military forces within a single 
construct of a Joint Power Projection Support Platform (JPPSP).  The JPPSP can be described as 
a single transportation node that will be developed to seamlessly integrate with and support the 
end-to-end military and commercial distribution network.  The inland multi-modal transfer 
facility, a key component of the JPPSP, can be described as a central node on a dual use2 
regional agile distribution network.  The JPPSP multi-modal transfer facility presents a 
capability to achieve rapid military deployment and responsive commercial support and will be 
designed for replication in other geographic regions of the US.  In the model Entities represent 
the objects moving through the simulation. Each entity has its own characteristics, referred to as 
attributes.   Resources are included as elements of the simulation that can be allocated to entities. 
Resources have a specified capacity and a set of states that they transition between during a 
simulation run.  The model includes four sub-models: The Highway Activity Sub-model 
simulates a gate process which will create missions to pickup or drop-off equipment inventory at 
a multi-modal terminal.   The Airlift Activity Sub-model simulates an airlift process which will 
create missions to pickup or drop-off equipment inventory at a multi-modal terminal.   The Rail 
Activity Sub-model simulates a rail process which will create missions to pickup or drop-off 
equipment inventory at a multi-modal terminal.   Finally, the Storage Activity Sub-model 
simulates a storage process which will receive and release equipment inventory to a highway 
tractor or yard hostler at a multi-modal terminal.    

 
1 Strategic Mobility 21 is a Congressionally mandated and independently funded applied research program through 
the Office of Naval Research.  The program is conducted under the auspices of the Center for the Commercial 
Deployment of Transportation Technologies (CCDOTT), a government-industry academic collaborative enterprise.  
2 Dual-use technology serves as a basis for both commercial and military products. 
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1.0 INTRODUCTION 
Strategic Mobility 213 (SM21) is an operational level concept that merges planning and 
execution of both commercial freight operations and the deployment and sustainment of joint 
military forces within a single construct of a Joint Power Projection Support Platform (JPPSP).  
The JPPSP can be described as a single transportation node that will be developed to seamlessly 
integrate with and support the end-to-end military and commercial distribution network.  The 
inland multi-modal transfer facility, a key component of the JPPSP, can be described as a central 
node on a dual use4 regional agile distribution network.  The JPPSP multi-modal transfer facility 
presents a capability to achieve rapid military deployment and responsive commercial support 
and will be designed for replication in other geographic regions of the US.  SM21 is being 
managed as a four-year advanced technology development and demonstration program. 

1.1 The Multi-Modal Terminal Model 
This manual documents the capabilities and functions of the SM21 Multi-Modal Terminal 
Model.  The Model was created using Arena Basic v 10.00 from Rockwell Software, Inc. 
(http://www.arenasimulation.com) and extended using Visual Basic for Applications (VBA).  
SIMAN is the underlying simulation engine that controls the execution of Arena simulation 
models. There are two (2) files that are needed to run the Model: SM21 Terminal Model 
vX_XX.doe and SM21 Terminal Model vX_XX.xls.  The .doe file is the Arena Model including 
the VBA code and the .xls file is the data input to the Model for scheduled arrivals and resource 
capacities.   The Excel data file by default is the Model file name and can be redirected to 
another input file at run-time as needed. 

2.0 THE MODEL 
Entities represent the objects moving through the simulation. Each entity has its own 
characteristics, referred to as attributes.   There are two (2) types of entities in the Model: 
entMission and entBatchMission.  A mission is a conceptual goal that needs to be accomplished 
within the simulation which could represent a container pickup from a storage area originating 
from a highway gate or an inter-yard repark storage work order.  A batched mission is a 
collection of missions that may represent an inbound consist or a highway convoy arrival. A 
batched mission will move the collection of missions together through the simulation until 
separated by the Model (e.g. railcar unloading). 
 
Resources are elements of the simulation that can be allocated to entities. They have a specified 
capacity and a set of states that they transition between during a simulation run.  There are nine 
(9) types of resources in the Model: resLanes, resStackedRows, resWheeledRows, resRunways, 
resTracks, resHostlers, resStackers, resAirMHEs and resRailMHEs. 

2.1 Highway Activity Submodel 
The Highway Activity Submodel simulates a gate process which will create missions to pickup or 
drop-off equipment inventory at a multi-modal terminal.   Single highway missions are created at 
                                                 
3 Strategic Mobility 21 is a Congressionally mandated and independently funded applied research program through 
the Office of Naval Research.  The program is conducted under the auspices of the Center for the Commercial 
Deployment of Transportation Technologies (CCDOTT), a government-industry academic collaborative enterprise.  
4 Dual-use technology serves as a basis for both commercial and military products. 

http://www.arenasimulation.com/
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a user-defined random interval while batched missions are created for scheduled convoy arrivals.  
Scheduled arrivals may become delayed.  Gate arrivals have a higher priority over departures in 
order to meet potential cut-off times and help reduce potential traffic at he entrance of the 
terminal.  Highway missions may go directly to terminal storage, airlift marshalling or rail 
marshalling areas and are transported by the highway tractor. The Model has the ability to 
account for highway inspections.  The Gate Capacity sheet from the Excel input file accounts for 
the degree of parallelism for each gate lane.  Typically this value would be either 0 or 1 
representing a gate clerk on-duty, however if handheld devices can be used or talk-backs 
installed routing to the gate house this number could possibly be larger.  During animation, 
highway missions are represented as green dots. 

2.2 Airlift Activity Submodel 
The Airlift Activity Submodel simulates an airlift process which will create missions to pickup or 
drop-off equipment inventory at a multi-modal terminal.   Batched missions are created for 
scheduled sortie arrivals.  An airlift mission should represent an equivalent container load unit of 
measure (TEU/FEU) as airlift mission transport 463L pallets. Scheduled arrivals may become 
delayed.  General servicing delays which account for any service action including nitrogen, 
oxygen and minor repairs should be included in the Activity-*Block-in Delay (minutes) values.  
Air MHEs are used for loading or unloading missions.  Loading activities have a higher priority 
for Air MHE requests. Airlift missions will request a yard hostler to perform the specific mission 
activity outside of the airfield and will only travel between the marshalling area and the terminal 
storage area.  Airlift holster requests have a higher priority over Rail.  The Model has the ability 
to account for airlift refueling, de-icing and cargo inspections.  Departure runway requests have a 
higher priority over arrivals.  During animation, highway missions are represented as blue dots. 

2.3 Rail Activity Submodel 
The Rail Activity Submodel simulates a rail process which will create missions to pickup or drop-
off equipment inventory at a multi-modal terminal.   Batched missions are created for scheduled 
inbound consist arrivals.  Scheduled arrivals may become delayed.  The Model will use the 
number defined missions to create per arrival as the capacity for each track.  For example, if a 
double stacked unit train contains 640 TEUs and each arrival track can hold 64 TEUs (roughly 
occupying 8,000 feet of track) then 10 ramp tracks will be required to drop the entire train on the 
multi-modal ramp and 64 would be entered in the Missions (per consist arrival): prompt and 10 
would be entered son the Rail Arrivals Excel Worksheet.  Rail MHEs are used for loading or 
unloading missions.  Loading activities have a higher priority for Rail MHE requests. Rail 
missions will request a yard hostler to perform the specific mission activity outside of the rail 
spur and will only travel between the marshalling area and the terminal storage area. The Model 
has the ability to account for U.S. Customs for an inland port consist move and rail inspections.  
Departure track requests have a higher priority over arrivals.  During animation, highway 
missions are represented as red dots. 

2.4 Storage Activity Submodel 
The Storage Activity Submodel simulates a storage process which will receive and release 
equipment inventory to a highway tractor or yard hostler at a multi-modal terminal.   Storage 
missions are created at a user-defined random interval to account for reparking orders.  Stackers 
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are used for picking or placing containers.  The Model has the ability to segregate equipment by 
wheeled or stacked rows.  During animation, highway missions are represented as yellow dots. 

3.0 GETTING STARTED 
After loading the Model, you should see four (4) sub models: Highway Gate Activity, Storage 
Activity, Rail Activity and Airlift Activity as shown in Figure 1.  To traverse the Model, use the 
Navigate Panel on the Arena Project Bar and click on the desired outline item or use the right 
mouse button on the Model Canvas View (main Window) and select Open Submodel or Close 
Submodel from the Action Popup Menu. 
 

 
Figure 1: Arena Top-Level Model 

 
Before running the Model, you’ll need to verify that the appropriate VBA Excel Object 
Reference is loaded for your system.  If you have Microsoft Office 2003 loaded on the machine 
you should be able to skip this step.  Go to the Arena menu and select Tools > Macro > Show 
Visual Basic Editor, or simply use the shortcut key combination of ALT-F11.  After the Visual 
Basic Editor is loaded, go to the VB menu and select Tools > References, you should see a screen 
similar to Figure 2.  Now select the appropriate Microsoft Excel XX.X Object Library which is 
installed on the machine and click the OK command button.  Save the VBA configuration by 
selecting File > Save SM21 Terminal Model vX_XX  from the VB menu and finally File > Close 
and Return to Arena to close the Visual Basic Editor. 
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Figure 2: Visual Basic Editor Reference 

 
The Model can be controlled either by the Run Toolbar (Figure 3), the Arena Run Menu or the 
assigned shortcut keys (Go F5, Pause ESC, End ALT+F5).  When the Model is started a series of 
VBA screens will be displayed to capture user defined changes to the Model (i.e. number of 
resources available) and associated runtime variables (i.e. activity delay times).  These 
configuration screens can be suppressed by setting the Area Model variable varUserPrompt to 
“0” via the Variable module located in the Basic Process Panel on the Arena Project Bar. 
 

 
Figure 3: Arena Run Toolbar 

4.0 MODEL CONFIGURATION SCREEN 
The Model Configuration Screen (Figure 4) allows the user to make any structural changes to the 
Model such as changing the number of resources available in the simulation.  Clicking the OK 
command button will upload any changes to the model, validate the model and then initializes 
the simulation to a run state.  The Cancel command button will ignore any changes to the model 
and initialize the simulation to a run state. 
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Figure 4: Model Configuration VBA Screen 

 
PROMPT DESCRIPTION 

Arrival/Capacity Input: Fully qualified location of the Excel input data file.  This input 
file defines the scheduled arrivals and resource capacity for the 
simulation. 

Simulation Length (days): Number of days to simulate. 
Hours per Day: Number of hours in a day to simulate. 
Storage-Wheeled Rows: Number of wheeled rows available. 
Storage-Row Capacity: The individual capacity of each wheeled row (i.e. slots).   
Storage-Stacked Rows: Number of stacked rows available. 
Storage-Row Capacity: The individual capacity of each stacked row (i.e. slots). 
Tracks: Number of tracks available. 
Gate Lanes: Number of gate lanes available. 
Runways: Number of runways available. 
 
The Excel data file which defines the model’s resource scheduled arrivals and work capacity is 
based on a 24 hour schedule.  Named ranges (Figure 5) are setup on each of the tabs (Convoy 
Arrival; Gate Capacity; Air Arrivals; AirMHE Capacity; Rail Arrivals; Rail Departures; 
RailMHE Capacity; Stacker Capacity; Hostler Capacity) which allows the Model to easily query 
the data.  The Time Slot column indicates the hour of a day and it is used for reference and 
should not be changed.  The Arrival, Departure and Capacity columns can be edited to reflect 
the appropriate scheduled arrivals/departures or resource capacity for the simulation.   
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Figure 5: Excel Named Ranges 

5.0 RUNTIME CONFIGURATION SCREEN 
The Runtime Configuration Screen allows the user to make changes to the simulation runtime 
variables for that specific instance.  This screen contains four (4) tabs organized by each sub 
model: Highway, Airlift, Rail and Storage.  To modify these values so that they are saved along 
with the Model you must manually change the Initial Value of the corresponding Arena Variable 
using the Arena Project Bar. 

5.1 Highway Tab 

 
Figure 6: Runtime Highway Tab 
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PROMPT DESCRIPTION VARIABLE 

*Missions (per 
convoy arrival): 

Number of missions to create for each 
scheduled convoy arrival. 

varConvoyArrivalMissions 

*Mission Schd 
Arrivals (% 
delayed): 

Value used to determine the percentage of 
delayed convoys. 

varConvoyArrivalDelay 

Delay (minutes): Minimum, mean and maximum arrival delay 
values in minutes.  Model uses a triangular 
distribution to return a value between minimum 
and maximum with the most likely values 
centered around the mean. 

varConvoyArrivalDelayMin, 
varConvoyArrivalDelayLikely, 
varConvoyArrivalDelayMax 

Single Mission 
(interval minutes): 

Random value using an Exponential 
Distribution to determine a highway mission 
arrival. 

varGateArrivalInterval 

Mission (% COFC): Value used to determine the percentage of 
highway COFC missions. 

varHighwayCOFC 

Mission (% bobtail-
in, out, double): 

Distribution of cumulative probabilities to 
determine a bobtail-in (pickup), bobtail-out 
(drop-off) or a double move mission.  The 
cumulative probabilities must add up to 100. 

varHighwayPickup, 
varHighwayDropOff 

Mission (% rail, 
airlift, storage): 

Distribution of cumulative probabilities to 
determine a direct highway move to rail, airlift 
or a storage area.  The cumulative probabilities 
must add up to 100. 

varHighwayDirectRail, 
varHighwayDirectAirlift 

Activity-Arrival 
Inspection (% true): 

Value used to determine the percentage of 
arrival missions to be inspected. 

varGateArrivalInsp 

Delay (minutes): Minimum, mean and maximum arrival 
inspection delay values in minutes.  Model uses 
a triangular distribution to return a value 
between minimum and maximum with the most 
likely values centered around the mean. 

varGateArrivalInspDelayMin, 
varGateArrivalInspDelayLikely, 
varGateArrivalInspDelayMax 

Activity-Loaded 
Arrival Delay 
(minutes): 

Minimum, mean and maximum loaded arrival 
delay values in minutes.  Model uses a 
triangular distribution to return a value between 
minimum and maximum with the most likely 
values centered around the mean. 

varGateArrivalDelayMin, 
varGateArrivalDelayLikely, 
varGateArrivalDelayMax 

Activity-Bobtail-in 
Delay (minutes): 

Minimum, mean and maximum bobtail-in delay 
values in minutes.  Model uses a triangular 
distribution to return a value between minimum 
and maximum with the most likely values 
centered around the mean. 

varGateBobTailInDelayMin, 
varGateBobTailInDelayLikely, 
varGateBobTailInDelayMax 

Activity-Departure 
Inspection (% true): 

Value used to determine the percentage of 
departure missions to be inspected. 

varGateDepartureInsp 

Delay (minutes): Minimum, mean and maximum departure 
inspection delay values in minutes.  Model uses 
a triangular distribution to return a value 
between minimum and maximum with the most 
likely values centered around the mean. 

varGateDepartureInspDelayMin, 
varGateDepartureInspDelayLikely, 
varGateDepartureInspDelayMax 

Activity-Loaded 
Departure Delay 
(minutes): 

Minimum, mean and maximum loaded 
departure delay values in minutes.  Model uses a 
triangular distribution to return a value between 
minimum and maximum with the most likely 
values centered around the mean. 

varGateDepartureDelayMin, 
varGateDepartureDelayLikely, 
varGateDepartureDelayMax 

Activity-Bobtail-out Minimum, mean and maximum bobtail-out varGateBobTailOutDelayMin, 
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Delay (minutes): delay values in minutes.  Model uses a 
triangular distribution to return a value between 
minimum and maximum with the most likely 
values centered around the mean. 

varGateBobTailOutDelayLikely, 
varGateBobTailOutDelayMax 

5.2 Airlift Tab 

 
Figure 7: Runtime Airlift Tab 

 
PROMPT DESCRIPTION VARIABLE 

*Missions (per airlift arrival): Number of missions to create for 
each scheduled airlift arrival. 

varAirArrivalMissions 

*Mission Schd Arrivals (% 
delayed): 

Value used to determine the 
percentage of delayed airlift arrivals. 

varAirArrivalDelay 

Delay (minutes): Minimum, mean and maximum 
scheduled arrival delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varAirArrivalDelayMin, 
varAirArrivalDelayLikely, 
varAirArrivalDelayMax 

Mission (% COFC): Value used to determine the 
percentage of airlift COFC missions. 

varAirliftCOFC 

Mission (% pickup, drop-off, 
double): 

Distribution of cumulative 
probabilities to determine a pickup, 
drop-off or a double move mission.  

varAirliftPickup, varAirliftDropOff 
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The cumulative probabilities must 
add up to 100 

Activity-*Land and Taxi Delay 
(minutes): 

Minimum, mean and maximum land 
and taxi delay values in minutes.  
Model uses a triangular distribution 
to return a value between minimum 
and maximum with the most likely 
values centered around the mean. 

varAirLandDelayMin, 
varAirLandDelayLikely, 
varAirLandDelayMax 

Activity-*Block-in Delay 
(minutes): 

Minimum, mean and maximum 
block-in and general servicing delay 
values in minutes.  Model uses a 
triangular distribution to return a 
value between minimum and 
maximum with the most likely 
values centered around the mean. 

varAirBlockInDelayMin, 
varAirBlockInDelayLikely, 
varAirBlockInDelayMax 

Activity-*Refueling (% true): Value used to determine the 
percentage of airlifts where refueling 
is needed. 

varAirRefueling 

Delay (minutes): Minimum, mean and maximum 
refueling delay values in minutes.  
Model uses a triangular distribution 
to return a value between minimum 
and maximum with the most likely 
values centered around the mean. 

varAirFuelDelayMin, 
varAirFuelDelayLikely, 
varAirFuelDelayMax 

Activity-Cargo Unloading Delay 
(minutes): 

Minimum, mean and maximum 
cargo unloading delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varAirUnloadDelayMin, 
varAirUnloadDelayLikely, 
varAirUnloadDelayMax 

Activity-Yard Hostler Delay 
(minutes): 

Minimum, mean and maximum yard 
hostler request delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varAirHostlerDelayMin, 
varAirHostlerDelayLikely, 
varAirHostlerDelayMax 

Activity-Cargo Inspection (% 
true): 

Value used to determine the 
percentage of airlift cargo 
inspections. 

varAirCargoInsp 

Delay (minutes): Minimum, mean and maximum 
cargo inspection delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varAirInspDelayMin, 
varAirInspDelayLikely, 
varAirInspDelayMax 

Activity-Cargo Loading Delay 
(minutes): 

Minimum, mean and maximum 
cargo loading delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varAirLoadDelayMin, 
varAirLoadDelayLikely, 
varAirLoadDelayMax 
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Activity-*De-Icing (% true): Value used to determine the 
percentage of airlifts where de-icing 
is needed. 

varAirDeIcing 

Delay (minutes): Minimum, mean and maximum de-
icing delay values in minutes.  
Model uses a triangular distribution 
to return a value between minimum 
and maximum with the most likely 
values centered around the mean. 

varAirDeIcingDelayMin, 
varAirDeIcingDelayLikely, 
varAirDeIcingDelayMax 

Activity-*Block-out Delay 
(minutes): 

Minimum, mean and maximum 
block-out delay values in minutes.  
Model uses a triangular distribution 
to return a value between minimum 
and maximum with the most likely 
values centered around the mean. 

varAirBlockOutDelayMin, 
varAirBlockOutDelayLikely, 
varAirBlockOutDelayMax 

Activity-*Taxi and Take-off Delay 
(minutes): 

Minimum, mean and maximum taxi 
and take-off delay values in minutes.  
Model uses a triangular distribution 
to return a value between minimum 
and maximum with the most likely 
values centered around the mean. 

varAirTakeOffDelayMin, 
varAirTakeOffDelayLikely, 
varAirTakeOffDelayMax 

5.3 Rail Tab 

 
Figure 8: Runtime Rail Tab 
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PROMPT DESCRIPTION VARIABLE 

*Missions (per consist arrival): Number of missions to create for 
each scheduled consist cut arrival. 

varRailArrivalMissions 

*Mission Schd Arrivals (% 
delayed): 

Value used to determine the 
percentage of delayed consist 
arrivals. 

varRailArrivalDelay 

Delay (minutes): Minimum, mean and maximum 
scheduled arrival delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varRailArrivalDelayMin, 
varRailArrivalDelayLikely, 
varRailArrivalDelayMax 

Mission (% COFC): Value used to determine the 
percentage of rail COFC missions. 

varRailCOFC 

Mission (% pickup, drop-off, 
double): 

Distribution of cumulative 
probabilities to determine a pickup, 
drop-off or a double move mission.  
The cumulative probabilities must 
add up to 100 

varRailPickup, varRailDropOff 

Activity-*IB Missions (% inland 
port move): 

Value used to determine the 
percentage of inbound consists 
originated from a port. 

varRailIBInlandPort 

Activity-*IB Spot Delay (minutes): Minimum, mean and maximum 
inbound consist spot delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varRailSpotDelayMin, 
varRailSpotDelayLikely, 
varRailSpotDelayMax 

Activity-*IB Inspection (% true): Value used to determine the 
percentage of inbound consists to be 
inspected. 

varRailIBInsp 

Delay (minutes): Minimum, mean and maximum 
inbound inspection delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varRailIBInspDelayMin, 
varRailIBInspDelayLikely, 
varRailIBInspDelayMax 

Activity-*IB Customs Delay 
(minutes): 

Minimum, mean and maximum 
inbound customs delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varRailIBCustomsDelayMin, 
varRailIBCustomsDelayLikely, 
varRailIBCustomsDelayMax 

Activity-Unloading Delay 
(minutes): 

Minimum, mean and maximum 
railcar unloading delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varRailUnloadDelayMin, 
varRailUnloadDelayLikely, 
varRailUnloadDelayMax 
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Activity-Yard Hostler Delay 
(minutes): 

Minimum, mean and maximum yard 
hostler request delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varRailHostlerDelayMin, 
varRailHostlerDelayLikely, 
varRailHostlerDelayMax 

Activity-*IB Release Delay 
(minutes): 

Minimum, mean and maximum 
inbound consist release delay values 
in minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varRailIBReleaseDelayMin, 
varRailIBReleaseDelayLikely, 
varRailIBReleaseDelayMax 

Activity-*OB Missions (% inland 
port move): 

Value used to determine the 
percentage of outbound consists 
destined to a port. 

varRailOBInlandPort 

Activity-Loading Delay (minutes): Minimum, mean and maximum 
railcar loading delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varRailLoadDelayMin, 
varRailLoadDelayLikely, 
varRailLoadDelayMax 

Activity-*OB Customs Delay 
(minutes): 

Minimum, mean and maximum 
outbound customs delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varRailOBCustomsDelayMin, 
varRailOBCustomsDelayLikely, 
varRailOBCustomsDelayMax 

Activity-*OB Inspection (% true): Value used to determine the 
percentage of outbound consists to 
be inspected. 

varRailOBInsp 

Delay (minutes): Minimum, mean and maximum 
outbound inspection delay values in 
minutes.  Model uses a triangular 
distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

varRailOBInspDelayMin, 
varRailOBInspDelayLikely, 
varRailOBInspDelayMax 

Activity-*OB Release Delay 
(minutes): 

Minimum, mean and maximum 
outbound consist release delay 
values in minutes.  Model uses a 
triangular distribution to return a 
value between minimum and 
maximum with the most likely 
values centered around the mean. 

varRailOBReleaseDelayMin, 
varRailOBReleaseDelayLikely, 
varRailOBReleaseDelayMax 
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5.4 Storage Tab 

 
Figure 9: Runtime Storage Tab 

 
PROMPT DESCRIPTION VARIABLE 

*RePark Work Orders (interval 
minutes): 

Random value using an Exponential 
Distribution to determine a repark 
mission. 

varStorageReParkInterval 

*ReParks per Interval: Number of repark missions to create 
per interval. 

varStorageReParkNumber 

Activity-Wheeled Receipt Delay 
(minutes): 

Minimum, mean and maximum 
wheeled receipt to storage delay 
values in minutes.  Model uses a 
triangular distribution to return a 
value between minimum and 
maximum with the most likely 
values centered around the mean. 

varWheeledReceiptDelayMin, 
varWheeledReceiptDelayLikely, 
varWheeledReceiptDelayMax 

Activity-Wheeled Release Delay 
(minutes): 

Minimum, mean and maximum 
wheeled release from storage delay 
values in minutes.  Model uses a 
triangular distribution to return a 
value between minimum and 
maximum with the most likely 
values centered around the mean. 

varWheeledReleaseDelayMin, 
varWheeledReleaseDelayLikely, 
varWheeledReleaseDelayMax 

Activity-Yard Stacker Delay 
(minutes): 

Minimum, mean and maximum yard 
stacker request delay values in 
minutes.  Model uses a triangular 

varStorageStackerDelayMin, 
varStorageStackerDelayLikely, 
varStorageStackerDelayMax 
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distribution to return a value 
between minimum and maximum 
with the most likely values centered 
around the mean. 

Activity-Stacked Receipt Delay 
(minutes): 

Minimum, mean and maximum 
stacked receipt to storage delay 
values in minutes.  Model uses a 
triangular distribution to return a 
value between minimum and 
maximum with the most likely 
values centered around the mean. 

varStackedReceiptDelayMin, 
varStackedReceiptDelayLikely, 
varStackedReceiptDelayMax 

Activity-Stacked Release Delay 
(minutes): 

Minimum, mean and maximum 
stacked release from storage delay 
values in minutes.  Model uses a 
triangular distribution to return a 
value between minimum and 
maximum with the most likely 
values centered around the mean. 

varStackedReleaseDelayMin, 
varStackedReleaseDelayLikely, 
varStackedReleaseDelayMax 

6.0 SIMULATION REPORTS 
Arena provides various drill-down reports located on the Reports Panel of the Arena Project 
Bar.  Those that are applicable to this Model are: Entities, Processes, Queues, Resources and 
User Specified.  Once the Model is successfully run you are able to run any of the reports to 
review the simulation outcome. 

6.1 Resource Summary Report 

 
Figure 10: Resource Summary Report 
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Instantaneous Utilization: The resource’s utilization (Number Busy/Number Scheduled) at each 
instance of time during the simulation run. This may include times that the resource was not 
scheduled in the system.  
 
Number Busy: The number of busy resource units.  
 
Number Scheduled: The number of scheduled resource units.  
 
Number Seized: The total number of seized resource units. 
 
Scheduled Utilization: The cumulative average utilization over the time period that the resource 
was actually scheduled in the system. 

6.2 Queue Summary Report 

 
Figure 11: Queue Summary Report 

 
Waiting Time: The period of time from when the entity (mission) enters a queue until the entity 
exits the queue. 

7.0 QUICK MODEL EXAMPLE 
If we look at the Queue Summary Report (Figure 11), specifically the Request Yard Hostler.Rail 
Queue, we’ll see that the average wait time is 0.62 of an hour or 37.2 minutes.  If we wanted to 
reduce the average wait time for that process, one thing we can do is allocate additional hostlers 
around the rail activity schedule from the Excel file.  Adding an additional 5 yard hostlers to the 
schedule from 0600 to 1000 on the Rail Arrivals worksheet and 1800 to 2200, we are able to 
reduce the waiting time to 0.53 of an hour or 31.8 minutes.
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APPENDIX A - LITERATURE REVIEW AND SOFTWARE SELECTION 
 
The Multi-Modal Terminal Model was created using Arena Basic v 10.00 from Rockwell 
Software, Inc. (http://www.arenasimulation.com) (Arena) and extended using Visual Basic for 
Applications (VBA).  SIMAN is the underlying simulation engine that controls the execution of 
Arena simulation models.  The decision to develop a multi-modal terminal model as a part of 
SM21 and to use Arena as the modeling tool was reached after completing an appropriate 
literature search. 
 
Literature associated with existing models did not indicate the flexibility and ease of use required 
by the SM21 program.  Therefore a decision was made to develop a model specifically designed 
to meet the demanding requirement of the SM21 program.  The SM21 Multi-Modal Terminal 
Model will be used to model a large number of different terminal environments found in the 
Southern California region.  This modeling effort is required to provide input data on terminal 
capacity and flow rates for the SM21 Southern California Agile Supply Network (SCASN) 
Model – a regional network model.  The Multi-Model Terminal Model will be required to 
evaluate all modes of transportation including air cargo.  
 
Since the decision was made to develop a model specifically for the SM21 program, a review of 
existing simulation software was conducted to find the one most capable software for quickly 
developing process modeling and simulation applications.   SM21 requires a simulation 
development tool to support a breadth of applications, scaled to fit different needs throughout the 
SM21 project life cycle, and the tool must integrate with other SM21, government, and 
commercial terminal stakeholder’s modeling and database systems.  The Extend simulation 
software developed by Imagine That, Inc. was also considered a viable option for use in 
modeling the Multi-Modal Terminal.  Extend was found to have many of the same features as 
Arena and is being used by the United States Navy, OPNAV-42 staff for evaluation of certain 
aspects of the Sea-basing concept.  However, taking all the SM21 requirements into 
consideration, the reviews indicated that Arena from Rockwell Automation better fulfills the 
SM21 requirements through the following advantages: 
 

 Preferred by United States Transportation Command for like simulations 
 Useable by business analysts 
 Use of sub-models provides “infinite” granularity 
 Low Cost ($800) 
 Visual 
 Object oriented 
 Can import from various sources (e.g. Excel) 
 Can export to various formats 
 Can create UML as an output 
 Custom features can be created via VBA or Visual Basic 

 
 
 

http://www.arenasimulation.com/
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GLOSSARY 
 

Terminology Definition 

AIRLIFT The performance or procurement of air transportation and services incident 
thereto required for the movement of persons, cargo, mail, or other goods. 

BOBTAIL A tractor operating without a trailer or chassis. 

CHASSIS The wheels and frame assembly that supports the container. 

COFC Container on flatcar. A container that moves on a flatcar without a chassis. 

CONTAINER A piece of equipment that has a removable chassis.  Usually used in ocean carriage 
or on stack trains. Comes in various sizes: 20, 40, 45, 48 and 53 foot. 

DEICING Deicing is a procedure by which frost, ice, slush or snow is removed from an aircraft 
to render it free of contamination. 

DISCRETE 
DISTRIBUTION 

The user-defined cumulative probability distribution is searched until a probability 
larger than a generated random number is found. The value associated with that 
probability is chosen. 

EXPONENTIAL 
DISTRIBUTION 

A continuous probability distribution with a mean ‘λ’: 

 

FLATCAR A railcar, which a trailer/container is placed on to move via the railroad. A car 
without roof or walls. 

GATE  A point at an intermodal terminal where a clerk checks in and out all containers and 
trailer. All reservations and paperwork are checked at the gatehouse. 

HAZMAT Hazardous Material. Product that is determined to be harmful and requires special 
handling as set forth by government agencies and the intermodal companies. 

HOSTLER An individual employed to move containers and trailers within a terminal or 
warehouse yard area. 

INBOUND Cargo moving from a rail terminal towards its destination. Generally used for cargo 
coming off a train and heading for final delivery to consignee. 

IN-GATE The transaction or interchange that occurs at the time a container is received by a 
rail terminal, container yard, or water terminal from another carrier. 

MHE Materials-Handling Equipment.  Mechanical devices for handling cargo. 

OUTBOUND Cargo moving from a shipper to rail ramp. Generally refers to cargo going onto a 
stack or conventional train. 

OUT-GATE The transaction or interchange that occurs at the time a container is delivered from a 
rail terminal, CY, or water terminal to another carrier. 

OVER-THE-ROAD 
(OTR) 

An all truck freight shipment, used in lieu of rail service, at a premium charge.  
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PALLET A wooden, paper or plastic platform usually with a top and bottom, on which 
packaged goods are placed to facilitate movement by some type of freight handling 
equipment. 

PICK-UP The act of calling for freight by truck at the consignors shipping platform. 

PICK-UP 
APPOINTMENT 

Scheduled time for pick-up or loading of a container from a shipper or consignee. 

RAMP A technical rail ramp not serviced by an actual train. 

SLOT A single storage/placement location which accommodates an asset. 

TERMINAL An assigned area in which containers are prepared for loading onto a train or are 
stored after discharge from a train. 

TEU Twenty-foot Equivalent Unit. A standard container size used for comparative 
measuring purposes. Normally applied to containers used by steamship lines (20, 40 
and 45 foot containers) 

TOFC Trailer On Flat Car. A trailer that moves on a flat car with the chassis attached. 

TRAILER A freight vehicle equipped with a permanent wheel assembly and a device for 
attaching to a tractor for movement. 

TRAIN ID A system to identify the trains origin and destination points, the day of the week for 
departure and the week of the year it moved. 

TRIANGULAR 
DISTRIBUTION 

A continuous probability distribution with a lower limit ‘a’, a mean ‘c’ and an upper 
limit ‘b’: 

 

WHEELED ROW A physical storage location which handles an asset with wheels such as a trailer, a 
bare chassis or a container married to a chassis. 

YARD A classification, storage or switching area. 
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